New Hyperion (Oracle EPM11) Quickstart

August 20171
Hyperion logon page

To get started, replace your Hyperion bookmark in your Internet Explorer browser (Note: only IE
version 8 or lower is supported) with the new link:
https://mureporting.millersville.edu/workspace/index.jsp

After you click on this new bookmark, the initial logon screen will be displayed. It should look
like this. Use your Banner/Hyperion userid and password to Login.
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Once you have successfully logged in, you will see the following screen which is your homepage
on the new system.

Click on “Explore” (see red circle below) to run queries and reports and to access your folders.
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Select a query

In the new Hyperion Quickstart, you must look at the Type to find a query, job or output. It is
recommended that you stretch the Type column so you can see the complete description.

The descriptions will be
Interactive Reporting Document
Interactive Reporting Job
Interactive Reporting Job Output

Notice the new icons representing the 3 new types to the left of the file name.

Select the folder (where your queries reside ex. Banner Queries) from the folders section on the
left. Double Click on the report name (Interactive Reporting Document) to select your query.

Oracle Enterprise Performance Management System Yorkspace, Fusion Edition - Windows Internet Explorer =1=1x]

% v |g, https: | fmureparting. millersvile, edufwarkspace/findex. jsp jlél |El |z‘ ILive Search |EE‘

File Edit View Favorites Tools Help

& & @ Qracle Enterprise Performance Management System ... @ - - @ - |3’ Page - @ Tools = 7
File Edit View Favortes Tools Help Welcome SGRAY | Log Off ORACLE"
W A B vEooe | W B R e 3 search [
/Banner queries =]ES|
Folders #+ | Name & [Tyee Modified Description |
=l [D Root |g] Reg class override summary Interactive Reporting Document £/30/07 3:01 PM Summarizes class overrides for requested department in requested te.
@ Administrator |g] Reg classroom meeting sched 35.bqy Interactive Reporting Document 4/20/07 4:36 PM
|£] Reg coop registrants.bqy Interactive Reporting Document BM2/07 4:32 PN Report shows students who are registered for cooperative education
* [ﬂ Broadcast Messages |£] Reg graduation dipl order etc Interactive Reporting Document 412607 11:50 AM Report lists degree candidates for requested term. User selects awarc
[E] Documentation |®] Reg graduation view by dept bqy Bepad J/ BI21/07 9:00 AM Report gives gradustion information by department and term requested
[E7 Pinnacle Queries | Reg graduation view by dept hist bay Interactive Reporting Document TIZ307 1052 AM Graduation history information by dept. § Gray 07/23/07
) @ Sample Content |g] Reg honors college Interactive Reporting Document §/23/07 3:36 PM Shows Honors College students who are enrolled for the requested te
) @ SAP gueries |g] Reg major department summary Interactive Reporting Document SM5/07 1:59 PM QOverview of students majoring in the dept and enrolled in requested te
@ Shared Workspace Pages (o] Reg majors by option etc. Interactive Reporting Document 5/5/07 1:43 PM Returns majors in your dept enrolled in requested term. Includes stude
Singularity 3h grades review.bgy Interactive Reporting Document S/21/07 11:40 AN REG MATH GRADES REVIEW This report is designed to display, for a
£ Test inore in your dept bay Interactive Reporting Document BI12/07 9:36 AM Reporte of minors in your department
[ velarie |®] Reg missing grade report.bgy Interactive Reporting Document 12/14/07 1128 AM  Reports missing grades for requested school and requested term. Put
| Reg offcampus status view Interactive Reporting Document /22109 3:45 PM Report shows section status for requested term for off-campus, Dow
|g] Reg room schedule matrix. bgy Interactive Reporting Document T/25/07 11:08 AM Matrix of classes in clazsrooms.
| |g] Reg room schedule matrix 85.bqy Interactive Reporting Document 51407 11:50 AM Dev. by Gail Childs
|g] Reg schedule for textbooks: Interactive Reporting Document 10420410 4:08 PM Developed by F. Axsmith for the Book Room, this report returns select
|£] Reg section status school Interactive Reporting Document 41307 10:40 AN Shows section infermation including enroliment for classes in requeste
| 9] Reg section status view Interactive Reporting Document 928009 B:53 AM Deapartment view of course seclions. Sorted many ways. Dev. by F
| 9] Reg send transfer eval packets bay Interactive Reporting Document 8121111 6:27 PM Report for Registrar Office use only
| Reg soc anth check bay Interactive Reporting Document 10/16/07 10:45 AM  Check majors with = = 45 credits.
|g] Reg summer sect status.bgqy Interactive Reporting Document 5/8/07 8:03 AM Section status report for all courses in summer terms. Includes a sumn
|g] Reg transfer credit accepted Interactive Reporting Document 6/21111 5:18 PM Transfer credit accepted by institution with grades and MU egquivalents
|g] Reg vet credits by term.bgqy Interactive Reporting Document 611110 3:52 PM This is a report of veterans and their current credits enrolled
|£] Reg Waitlist By Dept Interactive Reporting Document 41111 4:46 PN VWaitiist by department. Query created by C. Deen. Published by |. Gaj
| 8] Reg waitist By School Interactive Reporting Document 4111111 4:42 PM Waitliet by university school. Query crested by C. Deen. Publihed by
|2] Reg Waitlist for CRN Interactive Reporting Document 411511 11:40 AM Waitlist for CRN. Query created by C. Deen. Published by | Gajari 4/1
|2] Reg Waitlists for Dept Courses Interactive Reporting Document 4120111 11:38 AM Waitlist for department courses. Created by C. Deen 4/13/11. Publishe
|g] Reg workshop status view.bgy Interactive Reporting Document £/9/07 3:07 PM Reg workshop status view Report shows section status for workshoy
|g] Res breakdown by class and gender.bqy Interactive Reporting Document 8/8/07 2225 PN Produces a count by class and gender of resident students for a spec
|g] Res count by class w meal plan Interactive Reporting Document 4/18/07 12:06 PM This will produce a report of all resident students including their class
|£] Res count by gender.bqy Interactive Reporting Document 5/2/07 8:49 AN Produces a count of resident students for a specified term and by gen
|®] Res count by hall and gender.bqy Interactive Reporting Document 1115007 859 AM Creates count and ligt of resident students by hall and gender. modifier
4 B K | »

[ Explore: /Ban...
[pone [ [ [ [ Trusted sites ES
wstartl | €@ 00fF G | 23 indows Explorer =| [ 2 wicrosoft office... |[ @2 Internet Expl... ~ () Inhux-Ml(msuftO..‘I EEE LS PER L

C:\Users\glaporte. MU_DOMAIN\Documents\Oracle Enterprise Performance Management System.doc Page 3
11/15/2011



Navigation

1. Section Title Bar
The Section Title bar displays the section you are currently working in.
To hide or close the Section title:
On the View menu, click the section title bar.

2. Section Pane
This displays all the sections or tabs in a document. There are several types of sections,
queries, results, pivots, and report sections.
To hide or close the Section pane:
Click the X icon to the right of the section heading. This creates a larger viewing area for
reports.
To unhide the section pane, go to the View menu and select ‘Section/Catalog’.

3. Content Pane

The Content pane in the lower right hand corner of the window provides a view of the section

or tab you are using such as pivot, detail, results or report sections. To obtain a larger viewing
area, close the section pane.
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Click on the Process button to process the current query and enter your Banner user id and
password.

™ https:/ fmureporting.millersville.edu /workspace /dataaccess/Browse?REQUEST _TYPE=GET_DOCUMENT&DOC _ - Windows Internet Explorer

Selection techniques for variables in the query

To select a contiguous range of items:
e Click the first item in the range.
e Hold the Shift key and click the last item in the range. The entire range of items is selected.

To select discontinuous items:
CTRL-click each item (Windows)
Click the green check mark and press ok.

If a value is not available, type it in and click the green check mark.
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Choosing another section in the document

If the section pane is hidden, unhide it by clicking on the section/catalog icon on the standard
toolbar and highlight the section. Another option is to click the drop down arrow next to the
section name in the section title bar. See Orange box. You will see available sections and can
select another section from that list.
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If the section pane is visible, highlight the section and note the change on the section title bar.
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Preview document before printing (Pivots, results, tables)

(Not necessary for report sections (red white and blue page icon with the right corner folded
down)
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Print preview mode will display results, tables and pivots exactly as they will print with headers
and footers. The only exception is those sections which are of the report type. These can be
viewed in normal viewing mode exactly as they will print.
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Before you print a pivot, result or table section in the document, review it in print preview mode
where you can scroll up, down, left and right. You can only view one page at a time. Note the
page margins (the dotted lines) which can be moved by pressing and holding the mouse over the
margin until a two headed arrow appears. Drag the margin as needed.

Changing the page orientation
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If the report doesn’t fit on the page after scrolling left and right, change the page orientation. On
the main menu bar choose File - page setup. Choose the appropriate orientation either landscape
or portrait.

Landscape provides a much wider report.

This can also be accessed from print preview mode by right-clicking. Use this to add/change page
header/footer.

21|

Printer

Mame: HF Lazer)et 4000 Series PCL B j Froperties

Status: Default printer; Ready
Tupe: HF Laser)et 4000 Series PCL &
‘where:  boperdew

Comment:

Paper Orientation
Size: |Letter [B1/2%11in) j A " Partrait
Source: | Trap 1 j

Printing a Document

To print a document after previewing and adjusting the page orientation, click on the print icon
on the standard tool bar.
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Exporting a section to excel or to pdf

e On the File menu, point to Export and click section.
e Select a destination directory, and type a name.

e Choose the file format Excel from the Save as Type menu and click Save.
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Exiting your Query

Click the X in top right corner. A box will pop up ‘Save Changes?” Click ‘No’.
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Exiting Hyperion Quickstart

indows Internet Explorer

o findex.jsp

G-k

(8 |[42)[x] [ivesoon

Fle Edt View Favortes Tools

Help

5% &0 @ oracle Enterprise Performance Managsment System ..

-6 - o= -Too\sv

File Edit View Favorites Tools Help Welcome SGRAY | Log Off OFR ACLE"
#w B & % Expore m B
iBanner queries [l
Folders +[Name & [Tyee Modified Description -
=I [ Root £ Budget Reports Folder 5(25/11 5:38 Pl
[£1 Adminietrator [ Budget scheduled reports Folder 7126111 5:04 PM
Banner queries &) Fao Financial Aid Queries Folder 402007 418 PN Al Financial Aid Queries
| [ Broadcast Messages £ Library - Voyager Queries Folder 7027111 9:32 AM
[ Documentation i3 Payroll Jobs Folder 2711 921 AM
[ Pinnacte Queries &7 Professional Education Unt Folder /4107 9:59 PN Assessment reports for the School of Education

Sample Content
SAP queries

[ Shared Workspace Pages.
[ singularity

[ Test

[ Velaris

4 | »]

|9 Act48 pde submission

[H] Act8 submission test

[l Act8 submission test twa)

|9 Act AR Transaction Report- Invoices bay

[l Act bursar unapplid cash 1405 2241

[l Act Daily Gurfeed Report

[#] Act Depost Liavilties

[H| Act Deposit Table Balances

[#l Act Financesecurity gen query class no fomprof
[l Act FiN Arfeed

{8} Act FIN Arfeed Output - Cycle

[l Act Wipp receivable 1200 1331

[] Act what iz in Suspense

{8 Act what is in Suspense Output - Cycle

| Adm admits by interests bay

|9 Adm admis for dept with rank sat phone email
@] Adm appiicants by interests bay

8] Adm art admits bay

] Adm Art inquiry admitied paid

|9 Aam qual apps nurses bay

[#] Adm executive summary job

[H| Admexecutive summary test

{8l Adm executive summary-testing_colorchange
@] Adm institution number bay

8] Adm music inquiry admitted paid bay

9] Adm nursing applicants.bay

Interactive Reporting Document
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Document
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job Output
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job Qutput
Interactive Reporting Document
Interactive Reporting Document
Interactive Reporting Document
Interactive Reporting Document
Interactive Reporting Document
Interactive Reporting Document
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Job
Interactive Reporting Document
Interactive Reporting Document
Interactive Reporting Document

742810 3:23 Pl
TI27111 10:55 AW
7127411 10:55 AW
10/23/08 5:37 PM
TI2TI11 10:55 AM
TI26111 1243 PM
Ti2611 2:46 P
TI27i11 10:56 AW
TI27i11 10:56 AW
TI27A11 10:56 AW
Ti28011 11:03 PM
TI2TI11 10:56 AM
TI2TI11 10:57 AM
TI27/11 5:52 AWM
4411407 4:10 PK
4/27411 3:08 P
4411407 4:10 PW
4011407 411 PM
32310 231 PM
4411407 £:11 PR
8130010 12:03 PM
TI2TI1 12:46 PM
1/15/09 1:55 P
4411407 £:11 PW
11721/07 10:02 AN
411407 411 PM

Published 7/28/10 Security only H Manning
currently testing ‘PAYROLL' event

currently testing ‘REGPAY” event

To report bilings processed thru AR for your fund. User must enter a

Depostt Liabilties for Tuttion, Housing, and Others

provides a list of admitted students based on the non-academic interes
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list of students who are in the HACC Dual program and have appied ai
Run every Thursday at 11:00 Al- executive summary on admit,paid &1
testing save as feature. simiar to save of brio 6's ods which posts do

Assigns instutiion number (college or high school). /Add 1 to the numb
List of students who have applied to the music department. Includes in
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Always close Hyperion Quickstart by clicking ‘Log Off” at top right.

What if you need support?

o Call the TAC at ext 2371 (who will direct your call appropriately).
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